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ETABS v21.1.0 Release Notes
© 2023 Computers and Structures, Inc.

Notice Date: 11-August-2023

This document lists changes made to ETABS since v21.0.1, released 11-May-2023. Items marked with an
asterisk (*) in the first column are more significant.

API
Enhancements Implemented
* Ticket Description

9638 An enhancement has been made to the Application Programming Interface (API) to add
updated functions cPropFrame.GetChannel_2, SetChannel_2, GetDblAngle_2,
SetDblAngle_2, GetDblChannel_1, SetDblChannel_1, GetISection_1, SetISection_1,
GetTee_1, and SetTee_1 to include the fillet radius. Previous versions of these functions did
not include the fillet radius, but were otherwise identical. In the new functions, a fillet radius
of zero indicates no fillet radius.

9730 An enhancement has been made to the Application Programming Interface (API) to add new
functions cPropArea.SetDeck_1 and cPropArea.GetDeck_1. These functions have the
arguments for all slab and deck properties for all three types of deck including filled, unfilled,
and solid slab. They will check for the type of deck to assign and retrieve corresponding
properties. They supersede the functions cPropArea.SetDeck and cPropArea.GetDeck, which
previously did not set and retrieve the slab/filled material correctly.

Data Files
Enhancements Implemented
* Ticket Description

9322 An enhancement has been implemented where high-strength steel materials per JGJ/T 483-
2020 standard have been added to the Chinese material library. The steel frame design per
the Chinese 2018 code has also been updated to account for these materials.

9378 The Indian frame section library has been updated where numerous new double-angle and
double-channels sections have been added to the library. Additionally, (1.) The overall depth
for one of the existing sections (ISMC250) has been corrected. The depth was incorrectly
listed as 350mm instead of 250mm in the XML library. (2.) Missing section properties have
been added for some of the existing frame sections. Previously, the missing properties for
the affected sections were being calculated internally by the program when importing the
section.

9696 An enhancement has been made to Function definition (response spectrum, time history) to
allow the specification of a Default Function Folder that applies to all functions of type
"From File". This is a global setting: It applies to the current ETABS session, but it is not saved
with the model; instead, it is saved for the user when ETABS is closed. If the function data
file is not found in the path specified in the function definition, the software will recursively
search the following locations in the order given below, then load and use the first matching
data file: (1) Folder where the model file is saved, (2) Default Function Folder, (3)

Program installation folder. The corresponding API (Application Programming
Interface) functions have been updated as well.

Database Tables
Enhancements Implemented
* Ticket Description

6128 An enhancement was made to include the Story and the Pier or Spandrel label fields in the
Pier Design Overwrites tables and Spandrel Design Overwrites tables.
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* Ticket Description
9752 The following database tables were added: "Frame Assignments - Hinge - ASCE 41-17 - Conc

Shear Wall - Flex", "Frame Assignments - Hinge - ASCE 41-17 - Conc Shear Wall - Shear",
"Frame Assignments - Hinge - ASCE 41-17 - Conc CouplingBm - Flex", "Frame Assignments -
Hinge - ASCE 41-17 - Conc CouplingBm - Shear". Additionally, the model text file (.$ET) for
import and export has been enhanced to include data for ASCE 41-17 concrete coupling-
beam type auto-hinges.

Design – Concrete Frame
Enhancements Implemented
* Ticket Description

9748 An enhancement has been made to concrete frame design for the IS 456:2000 code to
include a check for the axial compression limit of 0.4fck according to IS 13920:2016 for the
column design under seismic loads. The warning/error message, when applicable, will be
displayed in the right-click design details form as well as in the design results table.

9777 An enhancement has been made in IS 456-2000 concrete frame design to include reference
to clause IS 13920:2016 Section 7.1 for the column axial compression limit check for seismic
design in both the right-click design details and the database output table.

9887 Several enhancements were made for the Chinese 2010 concrete frame design code: (1.)
Table 5-6 for Chinese concrete frame design in which an extra factor 1.1 was removed for
SDG "I". (2.) Table 5-8 for Chinese concrete frame design in which an extra factor 1.1 was
removed for SDG "9 SI and I" and "III". (3.) The limit ACR < 0.15 is no longer applied to
transition columns for determining the MMF and SMF factors for column design. (4.)
Corrected an issue for incorrectly reporting Seismic Design Grade Details. No design results
were affected.

Detailing
Enhancements Implemented
* Ticket Description
* 9607 An enhancement was made to show PT tendon vertical profiles in slabs and beams in

Detailing drawings. Previously the PT profiles were shown in the on-screen Detailing, but not
in the drawing sheets produced for printing and/or export.

Drafting and Editing
Enhancements Implemented
* Ticket Description

9832 An enhancement was made to the working-plane draw mode to add the fine-grid snap
option, to allow drawing of multiple line objects, and to allow drawing of 3- and 4-joint area
objects. Area objects drawn in the working plane must be within the bounds of the current
structure and grid system.

External Import and Export
Enhancements Implemented
* Ticket Description

1220 An enhancement has been implemented to allow more than one multi-step lateral load case
to be included in the design load combinations that are exported to SAFE.f2k model text
files. Corresponding steps of each multi-step load case are added together. All multi-step
lateral load cases in a design combination must have an identical number of steps,
producing a load combination with the same number of steps. Previously, only one multi-
step load case was supported in an exported load combination.

9705 An incident affecting the import of DXF files as floor plans was resolved. Layers containing
block inserts in the DXF file were not listed in the list of layers from which to import Columns
in the "DXF Import - Floor Plan" form. As a result, block inserts could not be imported. The
issue affected ETABS v20.1.0 through v21.0.1. Results agreed with the model as imported.
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* Ticket Description
* 9722 An enhancement to the export of .EXR files to Revit 2024 and their import from Revit 2024

has been implemented. ETABS line and area objects with "None" section properties are now
exported as Revit analytical frames and panels with no properties and no companion
physical elements. Revit analytical frames and panels with no properties are now imported
as ETABS line and area objects with "None" section properties. This feature requires the
forthcoming CSiXRevit 2024 and was developed to support the round-trip import and export
of point loads, line loads, and area loads assigned to such objects. Note that the round-trip
import and export of these loads to and from Revit 2023 is unchanged but that their round
trip import and export between ETABS and Revit 2024 requires this latest version of ETABS.

Installation and Licensing
Enhancements Implemented
* Ticket Description

9532 The version number has been changed to 21.1.0 for a new intermediate release.

Loading
Enhancements Implemented
* Ticket Description
* 9789 Two enhancements have been made to the handling of time-history and response-spectrum

functions: (1.) The addition of new functions and the modification of existing functions is
now allowed after the analysis is run and the model is locked. Modified functions used by
load cases that have already been run will cause their analysis results to be deleted, with
warning and an option to cancel. (2.) During analysis, only functions that are actually
referenced by the load cases currently selected to run will be processed. For models with
very long functions, this may increase the speed and slightly reduce the storage
requirements for analysis.

Results Display and Output
Enhancements Implemented
* Ticket Description
* 5370 An enhancement has been made to concrete frame design to add a new crack-width

(serviceability) design or check according to Eurocode 2-2004 and Italian NTC 2008 codes.
This feature is available for beam (M3) design and for the design or check of column
reinforcement. The crack width, concrete stress, and steel stresses are calculated and
compared against the limits imposed by the Eurocode 2-2004. The design/check results are
displayed in the right-click design detail report, display design info, and database tables. The
feature is currently limited to prismatic frame sections only.

* 9814 An enhancement has been made to the parallelized design and response-recovery
algorithms to increase the speed and reduce the memory usage and disk IO for models with
large analysis models and/or many long time-history functions. Parallelized response
recovery affects certain larger output tables and time-consuming graphical displays. In
addition, the “Program Determined” values for the number of threads to be used for
parallelized design and response recovery are now set to number of “Performance” cores on
CPUs with hybrid architecture (e.g., Intel 12th generation Core and newer) for better
efficiency over a larger range of models. This is set using command Analyze > Advanced
Design and Response Recovery Options.



ETABS v21.1.0 ISO #RELETA2110     11-Aug-2023 Page 4 of 12

Structural Model
Enhancements Implemented
* Ticket Description

9715 An additional parameter "Ultimate Strength Limit" has been added to ASCE 41-17 auto
frame hinges with the hinge tables "Table 10-7 (Concrete Beams - Flexure)", "Table 10-8
(Concrete Columns)", and "Table 10-19 (Concrete Coupling Beams - Flexure)". This
parameter is added to allow the user to specify a maximum limit to the C-point, or ultimate
strength, of the program-generated backbone curve, and it is set to 1.1 times the yield
strength by default.

9732 An enhancement was made to increase efficiency of slab meshing when the floor is
manually divided into several area objects, which would result in many meshing lines per
floor level.
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Analysis
Incidents Resolved
* Ticket Description

2873 An incident was resolved where section cuts that included forces from a shell object which
had an edge release assigned (Assign menu > Shell > Edge Releases) could be incorrect.
When the shell object with the edge release was assigned with auto-meshing, the
discrepancy in the reported section cut results was small. For unmeshed shell objects, forces
exerted by the shell along the released edges may not have been included in the computed
section cut results.

9551 A change has been made to not to allow multi-stepped wind and seismic load pattern
assignments to time history load cases and stages of nonlinear staged construction load
cases. When run, such load cases will be skipped and a corresponding message will be added
to Analysis Messages. Previously such assignments were permitted, but the load was not
applied or it used the first step of the load pattern, which was not consistent with the multi-
stepped nature of load pattern itself.

* 9617 An incident was resolved where the nonlinear stiffness of link elements that is used for
iteration and response recovery for nonlinear modal time-history (FNA) load cases could be
incorrect when all of the following conditions were met: (1.) The link property was not of
type “Damper – Exponential” and had at least one nonlinear degree of freedom. (2.) The link
property had “Stiffness Used for Linear and Modal Load Cases” set to “Nonlinear”. (3.) The
modal case used as the basis for the FNA load case did not use P-Delta or nonlinear stiffness.
(4.) More than one FNA load case was selected to be run in the same session. Note that
when the option to run load cases in parallel was selected, all FNA load cases were in
separate runs and therefore none were affected. When these conditions were met, zero link
stiffness was being used for the affected link properties certain for response-recovery
calculations for the second and subsequent FNA load cases is a given run (the first FNA load
case in any run was not affected). These calculations include joint reactions at affected links,
base reactions, and section cuts that include the affected link elements. No other response
quantities (displacements, member forces and stresses) were directly affected. However,
the iteration during the FNA analysis could be affected, and in some cases this could cause a
minor effect on other response quantities.

9682 An incident was resolved where a direct integration time history load case having
proportional damping specified as period ratio of a mode failed to run unless the modal load
case used for proportional damping had previously been run or was explicitly set to be run in
the same analysis session with the direct integration time history load case itself. When this
occurred, results were not available for the direct integration load cases. Now the modal
case will automatically be run, if not already done, when the direct integration load case is
run.

9688 An incident was resolved where mass or mass from loads that was specified on a null line
whose ends were unsupported would generate instability warnings during analysis because
the joints at the end of the null line were not included in the analysis mesh. This did not
affect loads on a null line, because they were being distributed to the underlying shells. Null
lines with mass or loads are now included in the mesh.

9784 An incident was resolved where the element model data file (with extension .MSH) that is
created when running the analysis inadvertently used a truncated file name for models with
dot(s) in their file names (e.g., “model.rev01.EDB” creating “model.MSH”). This could cause
results to not be available when another model with a similar name was run in the same
folder (e.g., “model.rev02.EDB”, again creating and overwriting “model.MSH”). Results were
otherwise not affected.
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API
Incidents Resolved
* Ticket Description

2054 An incident was resolved for the Application Programming Interface (API) where the
toolbars would not show next time ETABS was opened if certain API functions had been
called. Now the toolbar settings will not be saved when ETABS is closed if any API calls had
been made during the session.

9555 An incident was resolved for the Application Programming Interface (API) function
cPropFrame.GetTube_1 in which the corner radius was retrieved incorrectly. Previously, it
was always returned in database units, which are the internal units of the model. Now it is
returned correctly in the current units as previously set using the API.

9563 An incident was resolved for the Application Programming Interface (API) where the
functions cFrameObj.SetInsertionPoint and SetInsertionPoint_1 would trigger an exception
when called and not perform the expected function.

Database Tables
Incidents Resolved
* Ticket Description

8364 An incident was resolved where importing a duplicate CoreBrace BRB section property
through the database tables caused an abnormal termination. Now the duplicated section
property will be ignored or will replace the original, according to the specified options for
importing from tables.

9553 An incident was resolved where the table for cold-formed material property data would not
be displayed unless an aluminum material property had also been defined. No results were
affected.

9699 An incident was resolved for the AS 3600:2018 shear wall design preferences where the Wall
ductility Type was incorrectly shown in the tables. This was just a reporting issue and design
was not affected.

9714 An incident was resolved for concrete frame design codes “ACI 318-19” and “ACI 318-14”
where the reported torsion values for governing torsion stirrup bars and governing
longitudinal torsion rebars in the database table “Concrete Beam Shear Envelopes…” were
not correct. This was a reporting problem only. The detailed calculation reported in the
“Concrete Beam Design Information …” form was correct, and no other design results were
affected. The database tables "Concrete Beam Shear Envelopes..." for all codes have been
updated to add a new field key "VTorsion" which reports associated Torsion for Av/s. For
these tables, the following field keys and corresponding field names have been changed: (1.)
Key "At" --> "VRebar", Name "At" --> "VRebar (Av/s)", which reports VRebar (Av/s), (2.) Key
"TComboAt" --> "TTrnCombo", Name "T for At Combo" --> "TTrnCombo", which reports the
Torsion combination, (3.) Key "TAt" --> "TTrnTorsion", Name "T for At" --> "Torsion for
TTrnRebar", which reports design Torsion, (4.) Key "TorsionAt" --> "TTrnRebar", Name "At
Torsion" --> "TTrnRebar (At/s)", which reports At/s, (5.) Key "TComboAs" --> "TLngCombo",
Name "T for As Combo" --> "TLngCombo", which reports the Torsion combination for
longitudinal torsional rebar, (6.) Key "TAs" --> "TLngTorsion", Name "T for As" --> "Torsion
for TLngTorsion", which reports design Torsion for longitudinal torsional rebar, (7.) Key
"TorsionAs" --> "TLngRebar", Name "As Torsion" --> "TLngRebar (Al)", which reports
longitudinal torsional rebar Al. In addition, the following database tables have been
renamed. However, their table keys are unchanged: (1.) "Concrete Bm Design Summary - AS
3600-09" --> "Concrete Beam Design Summary - AS 3600-09", (2.) "Concrete Bm Design
Summary - AS 3600-2018" --> "Concrete Beam Design Summary - AS 3600-2018", (3.)
"Concrete Bm Design Summary - Chinese 2010" --> "Concrete Beam Design Summary -
Chinese 2010".
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* Ticket Description
9746 An incident was resolved where the Yes/No value of the "Use Yield Moment?" and "Use

Yield Rotation?" fields in the database table "Panel Zone Property Definitions - User
Nonlinear Data" table were reversed when the table data was imported. This issue only
affected the behavior when importing. The values of the fields were correct when the table
was exported, displayed through Display >Show Tables, or shown in the forms of the
graphical user interface. The import error affected interactive database editing (Edit menu >
Interactive Database), import from a database table file (text, Excel, Access, XML), or import
of the table using the API (Application Programming Interface). The model text file (.$ET)
was not affected.

9758 An incident was resolved where the nonlinear damping coefficient field "Trans NL Damping"
for an exponential damper type link property could be incorrectly shown when accessing the
"Link Property Definitions - Damper - Exponential" tables through the interactive database
(Edit menu > Interactive Database). If changes were made in any of the database tables in
the interactive editor and the results saved back into the model, then the incorrect damping
coefficients would be used in the model. Note that this issue did not affect the database
table when displayed or exported from the model, only in the interactive database editor.
This issue occurred when the display units were different than the database units of the
model. The database units are the internal consistent units used when the model is first
created. These are usually N-mm or lb-in, and can be seen in the .LOG file after an analysis is
run.

9830 An incident was resolved for the database table "Frame Section Property Definitions -
Concrete Beam Reinforcing" where the rebar area values were given in Length units instead
of Length^2 units. This also affected the unit conversion of the displayed values. This only
affected the values shown in the table, and did not affect the model unless this table was
imported in units different from the database units.

9856 An incident was resolved where the damping coefficient of the nonlinear exponential
damper link property was being unnecessarily converted for units when the damping
exponent was changed in the Link/Support Direction Properties form and the current units
were different from the database units. This occurred when the property was first saved
after changing the exponent, and the damping coefficient would be different next time the
Link/Support Direction Properties form was opened. This only occurred once when the
exponent was changed, and unit conversion after that was correctly performed. Also fixed a
similar issue in the interactive database.

Design – Composite Beam
Incidents Resolved
* Ticket Description

6548 An incident has been resolved where composite beam design overwrites were getting reset
to default values when interactive editing was used to edit/assign overwrites. Consequently,
the overwrites were missing in the .E2k and .$ET files as well.

9769 An incident was resolved where composite beam design per any of the AISC 360 codes was
sometimes incorrectly rejecting adequate trial beam sections when the beam design was
controlled by shear capacity. This was because while performing a preliminary design check,
ETABS was using a phi value of 0.9 for shear instead of 1.0 as allowed by the AISC code for
most rolled sections. However, if the trial section did pass the preliminary design check, then
the shear capacity in the output or in the interactive design form was subsequently correctly
computed and reported. This affected all versions of ETABS capable of designing composite
beams and when it occurred, the error was slightly conservative.

9797 An incident was resolved for the Eurocode 4-2004 composite column design in which the
properties of the concrete effective section have been changed to correctly account for the
concrete cover limits for fully encased sections in accordance with Clause 6.7.3.1(2) in the
EN 1994-1-1:2004. Previously, the full concrete section was used in the calculation, resulting
in slightly under-conservative design.
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* Ticket Description
9853 An incident was resolved for composite column design code "Chinese 2010" where the

design reported values of M33, M22, V2, and V3 inconsistently for a concrete-filled tube
when the magnification factors MMF-Column Top, MMF-Column Bottom, and SMF-Column
were overwritten. The reported forces were only calculated using the overwritten values of
the amplification factors when N/fcAg > 0.15. When N/fcAg was less than 0.15, the
overwritten values did not take effect. Now, if any MMF or SMF is overwritten, the
overwritten values will be used regardless of the value of N/fcAg. Where overwrites are not
specified, the MMF and SMF will still be calculated based on the value of N/fcAg.

9854 An incident was resolved for composite column design code “Chinese 2010” where the
software could terminate abnormally or stop responding when exporting the design details
for a concrete-filled tube to a Word document.

Design – Concrete Frame
Incidents Resolved
* Ticket Description

1966 An incident has been resolved for the torsion design of concrete beams with trapezoidal
sections and angle and tee sections with tapered webs. Previously, the outside area, the
area enclosed by the centerline of the torsional reinforcement (or the centerline of the
connecting wall), the outside perimeter, and the perimeter of the centerline of the torsional
reinforcement were not determined correctly to account for the trapezoidal shape or the
tapered web of the sections. The affected concrete design codes are ACI 318-19, ACI 318-14,
ACI 318-11, ACI 318-08, AS 3600-2018, AS 3600-2009, CSA A23.3-19, CSA A23.3-14,
Eurocode 2-2004, Italian NTC 2008, KBC 2016, KBC 2009, NZS 3101:2006, TS 500-
2000(R2018), and TS 500-2000.

2489 An incident was resolved for concrete frame design where the moments for negative
bending were sometimes reported as zeroes in the table “Flexural Design Moment Mu3” of
the design-envelope details, based on whether the tension-side required rebar (top) for the
negative moment was less than the compression-side required rebar (top) for the positive
moment, or vice-versa. The affected table can be accessed by right-clicking on the designed
beam, then Details > Envelope tab. The design procedure and all other results were not
affected. The design procedure considers all the steps within a multi-step load case or multi-
valued load combination so that the net enveloping rebar requirements are reported
correctly. The corresponding database tables are updated accordingly. This was a reporting
issue only.

4657 An incident was resolved for the Chinese 2010 concrete frame design code where the MMF
and SMF factors for columns were not matching for the top and bottom columns when all
the column lines did not have the same height. The design has been updated to now pick up
the factors based on Table 5.3.2.1 (GB 50011-2010 6.2.2, 6.2.5, JGJ 3-2010 3.10.2-2)
correctly. For SDG = I, the SMFs have been corrected to exclude the factor 1.1.

9616 An incident was resolved for Eurocode 2-2004 and Italian NTC 2008 concrete frame design
where the transverse torsional reinforcement area was calculated incorrectly. It was also
enveloped incorrectly when multiple load combinations and/or a load combination with
seismic loads were selected for design.

Design – Shear Wall
Incidents Resolved
* Ticket Description

9565 An incident was resolved for IS 456:2000 shear wall design of spandrels where the bottom
rebar of very deep link beams with a short span (i.e., where the span/depth ratio was 0.4 or
less) was not able to be designed.
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* Ticket Description
9821 An incident was resolved for concrete shear wall design code "Chinese 2010" where the SMF

and MMF factors were not program-determined by default. The design overwrites only
allowed the option to set a user value, with a default value of 1.0. Now these factors are
program-determined by default, with values calculated based on code sections GB 50011-
2011 6.2.2, 6.2.5, JGJ 3-2010 3.10.2-2, and they can be overwritten with user-values as
before.

Design – Steel Frame
Incidents Resolved
* Ticket Description

4194 An incident was resolved for composite column design code "Chinese 2010" where the
design reported a stress-check message "Section is Slender" for a concrete-filled tube
whenever e0/rc was greater than one, even when the column was in tension. Now this
condition is checked only if the column is in compression.

7855 An incident has been resolved for the Eurocode 3-2005, Italian NTC 2008, and Italian NTC
2018 steel frame design codes to perform the design of angle sections about the principal
axes instead of the geometric axes. The design includes the calculation of the design
moments, the effective section moduli (Weff,y and Weff,z), the equivalent uniform moment
factor (Cm), the critical moment coefficients (C1, C2, and C3), etc. Previously, these design
parameters were computed about the geometric axes.

9525 An incident was resolved for the CSA S16-19 steel frame design code where the Seismic
Category was not saved in the design preference form. Results were consistent with the
Design Category as shown when revisiting the form, as well as in the tables and report. In
addition, the text description of the Seismic Category was not updated correctly on the
design preferences form when design code was changed in the same session.

9601 An incident was resolved for the AS 4100-2020, AS 4100-1998 and NZS 3404-1997 steel
frame design codes where some steel frame overwrites were not written to .$ET (or .E2K)
text files, and these overwrites were lost when model was imported from a text file. In
addition, importing a model from a database-table file (text, Excel, Access, or XML) was
resetting the steel frame design code to AISC 360-16, and any assigned steel overwrites
were lost. All design codes were affected by the latter issue.

9703 An incident was resolved for the Chinese 2018 Steel frame design code where section Class
was not reported correctly. This was just a reporting issue and design was not affected.

9719 An incident was resolved for the CSA S16-19 steel frame design and CSA A23.3-19 concrete
frame and slab design codes where the default design load combinations used a scale factor
of 0.5 instead of 1.0 for companion snow load with live load.

9760 An incident was resolved for steel frame design codes "AISC 360-16", "AISC 360-10" and
"AISC 360-05" in which the design manuals have been updated for minor editorial changes:
(a) In section 3.6, the default value of the D/C ratio limit is 0.95 instead of 1.0. (b) In sections
3.6.1 and 3.6.2, the exception clause of AISC H1.3 is applicable to the "doubly symmetric
rolled compact section" instead of just the "doubly symmetric section." (c) In section 3.6,
there are additional minor editorial changes. These changes affect the documentation only.
Results are not affected.

9831 An incident was resolved for steel frame design where using auto-section selection when a
group selection was also defined was not working correctly. Auto-selection without group
selection did not have this issue.

Detailing
Incidents Resolved
* Ticket Description

9680 An incident was resolved for detailing where the section views
of columns with insertion points were not correct as the rebar cages were
shown outside the concrete surface.

9697 An incident was resolved where the drawing size was not correct when the model was in
metric units. This did not affect the use of US Customary units.
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* Ticket Description
9700 An incident was resolved related to Detailing Rebar Selection Rules for columns and walls

stacks where rebars were not immediately updated when changing the reinforcement bar
size. Now all rebars will be cleared and a new set will be added conforming to the updated
rules.

Documentation
Incidents Resolved
* Ticket Description

9658 Help documentation now has updated information for the Detailing command Column Bar
Selection and Curtailment Rules > Story > Splice Location.

Drafting and Editing
Incidents Resolved
* Ticket Description

9698 An incident was resolved where the operation Quick Draw Drop Panel would draw the drop
panel at an incorrect location if another area object was present at same X-Y location in
another story level.

External Import and Export
Incidents Resolved
* Ticket Description

1281 An incident was resolved where an inconsistency could have existed in older models
between story heights and the internally stored elevations. Now, when this is detected, the
user is notified and the story elevations are recomputed from story heights. This may have
affected models imported from text files into ETABS v13 or earlier versions, and the
discrepancy showed up in displays of the model.

1679 An incident was resolved where on-screen editing of a line (i.e., reshaping the line
connectivity) to create a brace or column was causing the local-1 axis of the brace or column
to be reversed. When this issue occurred, the affected brace or column was not correctly
imported from the .E2K or .$ET model text file.

8790 An incident was resolved where, when exporting a story from an ETABS model to SAFE (File
> Export > Story as SAFE v12 .f2k File), horizontal modal forces for response-spectrum load
cases were not always fully exported to the SAFE .F2K file at joints that were included in
rigid-diaphragm constraints. This issue did not affect joints assigned to semi-rigid
diaphragms or without a diaphragm assignment.

9735 An incident was resolved where user-defined P and V values specified as parameters for
program-generated ASCE 41-13 and ASCE 41-17 concrete hinges may not be correctly
imported from an ETABS .e2k text file. When the issue occurred, the model was imported
with the effected P and V values set to zero (0). The behavior of the model agreed with the
parameter value shown in the imported model.

Loading
Incidents Resolved
* Ticket Description

8751 An incident was resolved where deleting one or more intermediate stories was adding the
joint loads from the last deleted story to the story below instead of deleting those loads.

* 9474 An incident was resolved where seismic or wind loads that depend on mass were not always
updated to use the current mass when applied in a staged-construction load case. Running a
linear case with aforementioned seismic or wind loads before running staged construction
cases prevented the issue from occurring.
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Results Display and Output
Incidents Resolved
* Ticket Description

1678 An incident was resolved where link elements connected to a restraint were not drawn
correctly when displaying reactions as arrow plots and when the deformed shape was
displayed prior to displaying the restraint reactions.

9512 An incident was resolved where the seismic load tables were not available in the project
report that was presented in the user interface for certain models where the seismic load
force diagram and the seismic load table required more than one page to display. This did
not affect the seismic load table when the project report was sent to a printer or a Word file.

9642 An incident was resolved where the design report did not include all pages for steel frame
design for certain models. Design results presented graphically and in tables were not
affected.

9686 An incident was resolved where analysis results were not available and the model was
unlocked when opening a model file from a read-only folder. This could occur by closing the
model after running the analysis, and then setting the read-only flag on the folder containing
the model, or by copying the model and all results files to a read-only location. Analysis
results became available again after making the model folder and its contents writable. Now
results are available for display and output from a read-only location, but no changes to the
model can be saved (including modifying, deleting, or running load cases) while the location
is read-only.

9708 An incident was resolved in steel frame design codes “AISC 360-10”, “AISC 360-16”, "Italian
NTC 2018", as well as composite column design codes “AISC 360-10” and “AISC 360-16”, in
which the reported L_ltb factor in the “Parameters for Linear Torsional Buckling” table in the
Design Details form for ETABS Steel Frame Design was sometimes incorrect. The reported
value was taken from the governing load combination and governing station. The actual
value of the L_ltb factor that is used in the design is dependent on both the the load
combination and the design station, and this was correctly done. It was only the reported
value of L_ltb that could be incorrect.

9742 An incident was resolved for Indian IS 456:2000, Russian SP 63.13330.2012, and Vietnamese
TCVN 5574:2012 concrete frame design codes where the column headings were incorrect
for the rebar area and rebar percentage in the design report for Table: "Axial Force and
Biaxial Moment Design For P_u , M_u2 , M_u3". This only occurred when column rebar was
to be checked instead of designed.

9857 An incident was resolved for the AS 3600-2018 shear wall design report for Moderately
Ductile Walls where the Boundary Element check was always showing the Status as
"Required" instead of "Not Required" when the compressive stress was less than the stress
limit.

9883 An incident has been resolved where, for output type MaxMin, the minimum joint
displacement values at story levels plotted in the story response plots for multi-step cases
were incorrect. The maximum joint displacement values were not affected. Also, the
minimum values reported in the database table for joint displacement were correct.

Section Designer
Incidents Resolved
* Ticket Description

9870 An incident was resolved where a steel angle section, when included as reinforcement in a
concrete section, had only part of its axial area considered when calculating the PMM
interaction surface. This issue did not affect other types of steel shapes. Section properties
were correct for the section when an angle was included; only the interaction diagram was
missing a portion of the angle area.
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Structural Model
Incidents Resolved
* Ticket Description

1811 An incident was resolved where wind-pressure coefficients applied to three-noded area
objects was not displayed in the user interface. This was just a display issue and load
application was not affected.

9548 An incident was resolved where some of the section properties for the sole double-channel
section in the AISC15 and AISC15M section libraries were incorrect. The double-channel
section has been updated to 2C15X50 and 2C380X74 in the AISC15 and AISC15M libraries,
respectively, with a back-to-back distance of zero. It should be noted that v15.0 of the AISC
Shapes Database does not provide any double-channel sections. A single double-channel
section, however, has been given in the included AISC15 and AISC15M libraries as a
template for users to add more double-channel sections, if desired.

9768 An incident was resolved where, for a Panel Zone with User-defined Nonlinear Properties,
the panel zone nonlinear behavior beyond point E was always extrapolated even when the
"Load Carrying Capacity Beyond Point E" option was set to "Drops to Zero" in the User
Nonlinear Panel Zone Data form. This behavior has been fixed so that the behavior beyond
point E correctly reflects the chosen "Load Carrying Capacity Beyond Point E" option.

User Interface
Incidents Resolved
* Ticket Description

2004 An incident was resolved where customized keyboard shortcuts for plugins that have been
added to the Tools menu were not being saved when ETABS was closed. Now shortcuts
created using the Options menu > Customize Toolbars > Keyboard > Tools will be retained
next time ETABS is opened.

8472 An incident was resolved where, for models with multiple towers, plan views only displayed
the first tower when the perspective toggle was turned on.

9644 An incident was resolved where the "Force Deformation Data" form for Parametric Steel and
Concrete P-M2-M3 hinges (Define menu > Section Properties > Frame/Wall Nonlinear
Hinges) disabled the "Show Scaled Data" checkbox when the model was locked, preventing
the force-deformation plot display from being displayed using the scale factors in a locked
model. This was a display issue in this form only and did not affect analysis or results output.

9655 An incident was resolved where Deck or One-way membrane section properties were
duplicated in plan view in Standard Graphics mode. This made the view hard to read, but no
results were affected.

9723 An incident was resolved where selection/deselection by material property was not working
correctly for line objects that were assigned non-prismatic sections.

9761 An incident has been resolved where the shell forces/stresses were plotting in color even
after selecting the grayscale theme for screen colors in the output color options. An
enhancement was also implemented where the themes for the output color options have
been made the same as that for display colors for consistency. Previously, four themes were
available for display color options but only two themes for output color options.


